
Contents

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Your "WALKMAN" settingswhich affect baffle life

[battery life] (2) [Battery Care] [Off]
[brightness] [3]
[Media Go]

* (1) "EMPR" is a name of a standard for systems that support copyright protection system developed by Dpa (The Association for Promotion of Digital Broadcasting) as a content protection method for use in Digital Audio Broadcasting (DAB) equipment. (1) Available wireless services are dependent on your region. (1) Available wireless applications are dependent on your region.

This product contains technology owned by SECOM Company Limited under a license from the Regents of the University of California. (1) Available wireless services are dependent on your provider and the region. (1) Available wireless applications are dependent on your provider and the region.
TABLE OF CONTENTS

1. SERVICING NOTES ............................................. 4

2. DISASSEMBLY
   2-1. Disassembly Flow ............................................. 8
   2-2. Case (Front) Assy ............................................. 9
   2-3. Case (Rear) Assy Block ..................................... 10
   2-4. Open The Short-land ........................................ 10
   2-5. EMMC Board .................................................. 11
   2-6. VOL Key Assy ................................................ 11
   2-7. Support (M) .................................................. 12
   2-8. 3Pin HP Jack Block ........................................ 12
   2-9. MOTHER Board ............................................. 13
   2-10. LCD Assy (LCD1) .......................................... 14
   2-11. Battery Assy (BAT1) ..................................... 15

3. TEST MODE .......................................................... 16

4. EXPLODED VIEWS
   4-1. Case Section .................................................. 26
   4-2. LCD, Battery Section ....................................... 27
   4-3. Chassis Section ............................................. 28

5. ACCESSORIES ..................................................... 29

FLEXIBLE CIRCUIT BOARD REPAIRING

• Keep the temperature of soldering iron around 270 °C during repairing.
• Do not touch the soldering iron on the same conductor of the circuit board (within 3 times).
• Be careful not to apply force on the conductor when soldering or unsoldering.

SAFETY-RELATED COMPONENT WARNING!

COMPONENTS IDENTIFIED BY MARK △ OR DOTTED LINE WITH MARK △ ON THE SCHEMATIC DIAGRAMS AND IN THE PARTS LIST ARE CRITICAL TO SAFE OPERATION. REPLACE THESE COMPONENTS WITH SONY PARTS WHOSE PART NUMBERS APPEAR AS SHOWN IN THIS MANUAL OR IN SUPPLEMENTS PUBLISHED BY SONY.

ATTENTION AU COMPOSANT AYANT RAPPORT À LA SÉCURITÉ!

LES COMPOSANTS IDENTIFIÉS PAR UNE MARQUE △ SUR LES DIAGRAMMES SCHÉMATIQUES ET LA LISTE DES PIÈCES SONT CRITIQUES POUR LA SÉCURITÉ DE FONCTIONNEMENT. NE REMPLACER CES COMPOSANTS QUE PAR DES PIÈCES SONY DONT LES NUMÉROS SONT DONNÉS DANS CE MANUEL OU DANS LES SUPPLÉMENTS PUBLIÉS PAR SONY.

关于安全相关零部件的警告

原理图和零件清单中标有△记号的零部件，或带有△记号的虚线所表示的零部件，对于安全操作至关重要。更换时，必须依据本手册或索尼公司追加发行的手册中列明的零件号，使用索尼公司的零件进行。
ABOUT THE METHOD OF DISTINGUISHING THE SPEAKER ATTACHMENT MODEL

NWZ-E463 and NWZ-E464 have the model to whom the speaker is attached (NWZ-E463K/E464K).
However, the model name of the main unit of WALKMAN of NWZ-E463K and E464K are NWZ-E463 and NWZ-E464.
The setting of the firmware is different in the WALKMAN for single sales model and the WALKMAN to which the speaker is attached.
Therefore, it is necessary to distinguish whether the WALKMAN brought in to the repair is the WALKMAN to which the speaker is attached.

Distinction method:
In the WALKMAN for supplied speaker model, marking label is given on the support (M).
Note: When you exchanged the support (M), peel off the marking label from the old support (M) before it exchanges it, and try to paste it to the new support (M).

ABOUT THE HANDLING OF THE BATTERY ASSY (BAT1)

When the battery assy (BAT1) is removed, insulate the end of wire by a tape etc. to prevent short-circuited of the wire part of battery assy (BAT1).

ABOUT THE MODEL NAME OF “WALKMAN” MAIN UNIT

The model name of “WALKMAN” main unit for NWZ-E463HK/E463K/E464K is the following model name.

<table>
<thead>
<tr>
<th>Model Name</th>
<th>“WALKMAN” Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>NWZ-E463HK</td>
<td>NWZ-E463</td>
</tr>
<tr>
<td>NWZ-E463K</td>
<td>NWZ-E463</td>
</tr>
<tr>
<td>NWZ-E464K</td>
<td>NWZ-E464</td>
</tr>
</tbody>
</table>
**NOTE THE COMPLETE EMMC BOARD REPLACING**
When the complete EMMC board is replaced, process it according to the following.

**1. Destination setting**

**1-1. Outline**
The destination code corresponding to each region must be installed into the EMMC board with the destination setting tool.

**EMMC board**

<table>
<thead>
<tr>
<th>Model</th>
<th>Capacity</th>
<th>Part No. of complete EMMC board</th>
<th>Pre-installed destination code</th>
</tr>
</thead>
<tbody>
<tr>
<td>NWZ-E463/E463HK/E463K</td>
<td>4GB</td>
<td>9-885-159-61</td>
<td>E</td>
</tr>
<tr>
<td>NWZ-E464/E464K</td>
<td>8GB</td>
<td>9-885-159-62</td>
<td>E</td>
</tr>
<tr>
<td>NWZ-E465</td>
<td>16GB</td>
<td>9-885-159-63</td>
<td>E</td>
</tr>
</tbody>
</table>

**1-2. Preparation**

**Note 1:** Please use this Tool in Windows XP or later.
**Note 2:** Please install Windows Media Player 11 or later to make the unit recognize as MTP.
**Note 3:** Confirm the method of obtaining the destination setting tool to the service headquarters.

**Procedure:**

1. Unzip the destination setting tool.
2. Open the unzipped “change_destination_NWZE460” folder, and the following folders are displayed.

```
change_destination_NWZE460_CA
change_destination_NWZE460_CA_SP
change_destination_NWZE460_CEV
change_destination_NWZE460_CEV_SP
change_destination_NWZE460_CEW
change_destination_NWZE460_CEW2
change_destination_NWZE460_CEW2_SP
change_destination_NWZE460_CEW_SP
change_destination_NWZE460_CN
change_destination_NWZE460_CN_SP
change_destination_NWZE460_E
change_destination_NWZE460_E1
change_destination_NWZE460_E1_SP
change_destination_NWZE460_E_SP
change_destination_NWZE460_IN
change_destination_NWZE460_IN_SP
change_destination_NWZE460_MX2
change_destination_NWZE460_MX2_SP
change_destination_NWZE460_MX3
change_destination_NWZE460_MX3_SP
change_destination_NWZE460_U
change_destination_NWZE460_U2
change_destination_NWZE460_U2_SP
change_destination_NWZE460_U_SP
```

3. Select the folder corresponding to the destination of the “WALKMAN” repaired, and copy the selected folder to root directory of C drive on PC.

**Note 4:** Above folder in step 3 can be saved any drive as long as the folder path is with English (one byte character).
Described with the example that “the folders were saved under root directory of C drive” on this service manual.
1-3. How to use the destination setting tool

Note 1: Please use this tool after closing other application software.

Will be described with below conditions as an example.
Model : NWZ-E463/E464/E465
Destination : E

Procedure:
1. Turn on power of the WALKMAN, and connect it to PC.
2. Start the command prompt application software, and change
the folder pass to your desired folder.
(Example: C:\change_destination_NWZE460_E)

C:\>cd c:\change_destination_NWZE460_E

3. Input “updating-mtp” and press the Enter key on PC.

C:\change_destination_NWZE460_E>updating-mtp

4. If the following message is displayed, input “y” and press the
Enter key on PC.

Note 2:
When the Enter key on PC is pressed, the WALKMAN is format-
ted.

MTP F/W Update will start.
The WALKMAN unit reboots automatically after updating.
Before starting this program, close other application such
as WMP, Napster and Rhapsody etc.

Does this program run? (y/n)

5. The following message is displayed. Then, destination setting
operation starts.

F/W Updating starts.
Please wait for a while until updating is completed.

6. The WALKMAN reboots automatically after the destination
data is updated. After rebooting, check that connecting USB
(MTP) is displayed on the liquid crystal display of the WALK-
MAN.
7. Input “EXIT” to close the command prompt application soft-
ware.
8. Disconnect the WALKMAN from PC.
9. Turn the power on of the WALKMAN.
10. Press the [BACK] key for more 1.5 seconds, the home menu is
displayed.
11. Slide the [HOLD] key from OFF to ON.

12. Press the key as following order.

[▶] → [VOL -] → [VOL +] → [▶] → [BACK] →
[▶] → [▶] → [▶] → [BACK] → [▶]

13. The WALKMAN reboots and the color bar is displayed on the
liquid crystal display.
14. Enter the test mode when any keys are pressed in the state
of step 13, and slide the [HOLD] key from ON to OFF.
15. Press the [◀]/[◥] keys to select the “OTHER”, and press the
[▶] key to enter the minor item.
16. Press the [◀]/[◥] keys to select the “DEST”.
17. Press the [◀]/[◥] key, and check if the destination is updated
properly.

Note:
Execute “Reset all settings” absolutely at the end (Refer to right).

2. Format

Formatting memory [Format]
You can format the built-in flash memory of your “WALKMAN.”

Note:
• If the memory is formatted, all data (songs, videos, photos, etc.,
including sample data installed at the factory, bundled software in-
staller, and the User Guide) will be erased. Be sure to verify the data
stored in memory prior to formatting, and export any important data
to the hard disk of your computer.
• Be sure not to initialize (format) the built-in flash memory of your
“WALKMAN” using Windows Explorer. If you have formatted with
Windows Explorer, format again using your “WALKMAN.”

1. From the Home menu, select [Settings] ➔ [Common Set-
tings] ➔ [Reset/Format] ➔ [Format].
2. Select [Yes].
[All data will be deleted. Proceed?] appears.
3. Select [Yes].
When initialization finishes, [Memory formatted.] appears.

3. Reset all setting

Returning to the factory settings [Reset All Settings]
You can reset your “WALKMAN” to the default settings. Reset-
ting your “WALKMAN” will not delete data such as music, video,
and photos.

1. From the Home menu, select [Settings] ➔ [Common Set-
tings] ➔ [Reset/Format] ➔ [Reset All Settings] ➔ [Yes].

Note:
• If you select this function during playback, your “WALKMAN” will
pause playback before performing the reset process.
### 4. Wallpapers setting

How to install the wallpaper files into the WALKMAN.

**Note:** Confirm the method of obtaining the wallpaper files to the service headquarters.

**Procedure:**
1. Unzip the wallpaper files to get the following files (jpeg file).

   Folder name: WALLPAPERS
   - W001.jpg
   - W002.jpg
   - W003.jpg
   - W004.jpg
   - W005.jpg
   - W006.jpg

2. Connect the WALKMAN to PC.
3. Start windows explorer. Then, open [WALKMAN] - [StorageMedia].
4. Open “PICTURE” folder located under “StorageMedia” folder.
5. Copy the “WALLPAPERS” folder in step 2 under the “PICTURE” folder.

#### COLOR VARIATION

<table>
<thead>
<tr>
<th>Model</th>
<th>Destination</th>
<th>Black</th>
<th>Red</th>
<th>Blue</th>
<th>Pink</th>
<th>Green</th>
<th>Gold</th>
</tr>
</thead>
<tbody>
<tr>
<td>NWZ-E463</td>
<td>US</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Canadian</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>AEP, UK</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>East European</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>E, Australian, Tourist</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Mexican</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Chinese</td>
<td>●</td>
<td>–</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>●</td>
</tr>
<tr>
<td>NWZ-E463HK</td>
<td>AEP, UK</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>East European</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>NWZ-E463K</td>
<td>AEP, UK</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>E, Tourist</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Mexican</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>NWZ-E464</td>
<td>US</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Canadian</td>
<td>●</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>AEP, UK</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>East European</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>E, Australian, Tourist</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>●</td>
<td>–</td>
<td>●</td>
</tr>
<tr>
<td></td>
<td>Mexican</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>NWZ-E464K</td>
<td>Canadian</td>
<td>●</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>NWZ-E465</td>
<td>US</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Canadian</td>
<td>●</td>
<td>–</td>
<td>●</td>
<td>●</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>E, Australian, Tourist</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td></td>
<td>Mexican</td>
<td>●</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>
This set can be disassembled in the order shown below.

### 2-1. DISASSEMBLY FLOW

```
SET

2-2. CASE (FRONT) ASSY
     (Page 9)

2-3. CASE (REAR) ASSY BLOCK
     (Page 10)

2-4. OPEN THE SHORT-LAND
     (Page 10)

2-5. EMMC BOARD
     (Page 11)

2-6. VOL KEY ASSY
     (Page 11)

2-7. SUPPORT (M)
     (Page 12)

2-8. 3PIN HP JACK BLOCK
     (Page 12)

2-9. MOTHER BOARD
     (Page 13)

2-10. LCD ASSY (LCD1)
      
     (Page 14)

2-11. BATTERY ASSY (BAT1)
      
     (Page 15)
```
Note: Follow the disassembly procedure in the numerical order given.

2-2. CASE (FRONT) ASSY

1. two screws (P2 M1.4)

Rear side view (bottom side)

Left side: case (front) assy

panel (rear) assy block

Insert your nail in the gap between case (front) assy and panel (rear) assy block. Then slide it to arrow direction to remove claws of panel (rear) assy block.

Right side: case (front) assy

panel (rear) assy block

Insert your nail in the gap between case (front) assy and panel (rear) assy block. Then slide it to arrow direction to remove claws of panel (rear) assy block.

2. six claws

3. Insert your nail in the gap between case (front) assy and panel (rear) assy block. Then slide it to arrow direction to remove claws of panel (rear) assy block.

4. two claws

5. case (front) assy

6. case (front) assy

7. case (front) assy
2-3. CASE (REAR) ASSY BLOCK

Note: When installing panel (rear) assy block, the position of switch and guide (hold) is set and installed.

2-4. OPEN THE SHORT-LAND

Note 1: This illustration sees the mechanical commonness block from LCD assy side.
Note 2: Make sure to remove one solder to become an open state before disassembling the mechanical commonness block.
Note 3: Solder the short-land after all wirings are connected when you exchanged some mounted board.

Remove the solder of short-land (SL9501).
2-5. EMMC BOARD

Note: Lift vertically the EMMC board when you remove the connector.

2-6. VOL KEY ASSY

- Wire processing of VOL key wire

Peel the copper leaf (coral).

Remove two soldered joints of VOL key wire.
2-7. SUPPORT (M)

- Rear side view -

(NWZ-E463K/E464K)

1. marking label
   Note: When you exchanged the support (M), peel off the marking label from the old support (M) before it exchanges it, and try to paste it to the new support (M).

2. sheet (PWB)

3. boss

4. support (M)

5. Peel the copper leaf (coral).

6. Lift wires of battery assy (BAT1).

7. Wire processing of battery assy (BAT1)

8. - Rear top side view -

2-8. 3PIN HP JACK BLOCK

- Rear top side view -

5. 3pin HP jack assy flexible board

6. three claws

7. two claws

8. screw (M1.4)

9. escutcheon

10. 3pin HP jack block
2-9. MOTHER BOARD

2. Remove two solders of battery assy (BAT1).
   Note 1: When the battery assy (BAT1) is removed, refer to “ABOUT THE HANDLING OF THE BATTERY ASSY (BAT1)” (page 4).

• Wire processing of battery assy (BAT1)

   wire of battery assy (BAT1)

3. Remove two solders of VOL key wire.

4. Cut and peel off the sheet (MOTHER).

   Note 2: When assembling, please cut the polyimide sheet for service in the following size and paste it to the part where the sheet (MOTHER) was peeled off.

   3 mm
   4 mm
2-10. LCD ASSY (LCD1)

1. Remove the LCD assy flexible board in the direction of arrow A.

Note 1: There is a possibility of damaging LCD assy flexible board when removing excluding the direction of arrow A.

Note 2: Please match the position of two ditches and two ribs when you install LCD assy flexible board.
If putting into the connector shift ditch and rib, connector will be broken.

OK

NG

NG
2-11. BATTERY ASSY (BAT1)

Remove two solders of battery assy (BAT1).

Note 2: When the battery assy (BAT1) is removed, refer to “ABOUT THE HANDLING OF THE BATTERY ASSY (BAT1)” (page 4).
1. SETTING THE TEST MODE

**Note:** Perform the test mode in the state of 3.6 V or more in the battery voltage.

**Setting method:**
1. Turn the power on.
2. Press the [BACK] key for more 1.5 seconds, the home menu is displayed.
3. Slide the [HOLD] key from OFF to ON.
4. Press the key as following order:
   - \[b\] # \[VOL –\] # \[VOL +\] # \[b\] # \[BACK\]
5. The set reboots and the color bar is displayed on the liquid crystal display.
6. Enter the test mode when any keys are pressed in the state of step 5, and slide the [HOLD] key from ON to OFF.

**Note:** The destination setting and sound pressure regulation setting cannot be executed by this test mode.

2. RELEASING THE TEST MODE

1. Display the major item selection screen.
2. Press the \[v\]/\[V\] keys to select the “EXITTEST”, and press the \[B\] key to select the “SURE ?”.
3. Press the \[u\] key, turn the power off and release the test mode.

3. CONFIGURATION OF THE TEST MODE

<table>
<thead>
<tr>
<th>Major item</th>
<th>Major item switching: [a]/[v] keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>[H] key</td>
<td>[H] key</td>
</tr>
<tr>
<td>[H] key</td>
<td>[H] key</td>
</tr>
<tr>
<td>Start</td>
<td>BACK key</td>
</tr>
<tr>
<td>Automatic</td>
<td></td>
</tr>
<tr>
<td>Finish</td>
<td></td>
</tr>
<tr>
<td>or Result</td>
<td></td>
</tr>
</tbody>
</table>

3-1. Power (POWER)

**Screen display**

- MPTAPP (X.XX.XX)
- POWER—VCHK
- AUDIO—ACHK
- VIDEO—DSVCHK
- VIDEO OUT—CHGCHK
- OTHER—BATTCHK
- CELESTE—RMVBATT
- DAC
- DIREC
- FM
- SHUTDOWN
- EXITTEST

4-1-1. Power supply voltage check (VCHK)

This mode is used in case power supply voltage in the state where all power supply lines are starting is checked.

**Checking method:**
1. Enter the test mode.
2. Press the \[a]/\[v\] keys to select the “POWER”, and press the \[H\] key to enter the minor item.
3. Press the \[a]/\[v\] keys to select the “VCHK”.
4. Press the \[H\] key, all power supply lines are started.

**Screen display**

- POWER VCHK
- START

In this state, the power supply voltage of each power supply line can be confirmed by measuring the voltage.
5. Press the [BACK] key, return to minor item selection screen.

4-1-2. Consumption current (audio playback) check (ACHK)

This mode is used in case consumption current (audio playback) is checked in the state where “1 kHz 0 dBs L-ch/R-ch VOLUME: 15” audio signal is outputted.

**Checking method:**
1. Enter the test mode.
2. Press the \[a]/\[v\] keys to select the “POWER”, and press the \[H\] key to enter the minor item.
3. Press the \[a]/\[v\] keys to select the “ACHK”.
4. Press the \[H\] key, “1 kHz 0 dBs L-ch/R-ch VOLUME: 15” audio signal is outputted.

**Screen display**

- POWER ACHK
- 1kHz 0dBs L/Rch
- HPOUT [ VOL: 15 ]

5. In this state, each time the \[H\] key is pressed, LCD back light on/off switch is performed.
6. Press the [BACK] key, return to minor item selection screen.
4-1-3. Standby current check (DSVCHK)
This mode is used in case standby current is checked.

Checking method:
1. Enter the test mode.
2. Press the \[\text{[A]}]/\[\text{V}\] keys to select the “POWER”, and press the \[\text{[B]}\] key to enter the minor item.
3. Press the \[\text{[A]}]/\[\text{V}\] keys to select the “DSVCHK”.
4. Press the \[\text{[C]}\] key, enter the state of the deep sleep.
5. Press the [BACK] key, release the state of the deep sleep.

**Screen display**

```
POWER DSVCHK
OK
```

6. Press the [BACK] key, return to minor item selection screen.

4-1-4. Charge current check (CHGCHK)
This mode is used in case charge current is checked.

Checking method:
1. Enter the test mode.
2. Press the \[\text{[A]}]/\[\text{V}\] keys to select the “POWER”, and press the \[\text{[B]}\] key to enter the minor item.
3. Press the \[\text{[A]}]/\[\text{V}\] keys to select the “CHGCHK”.
4. Press the \[\text{[C]}\] key, the charge setting is displayed.

**Screen display**

```
POWER CHGCHK
AC
```

5. In this state, each time the \[\text{[C]}\] key is pressed, the port setting for the charge is changed as shown in the table below.

<table>
<thead>
<tr>
<th>Port control</th>
<th>CHG_XCHGEN</th>
<th>CHG_PEN1</th>
<th>CHG_PEN2</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>L</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>USB500</td>
<td>L</td>
<td>H</td>
<td>H</td>
</tr>
<tr>
<td>USB100</td>
<td>L</td>
<td>H</td>
<td>L</td>
</tr>
</tbody>
</table>

6. Press the [BACK] key, return to minor item selection screen.

4-1-5. Battery voltage detection check (BATTCHK)
This mode is used in case battery voltage is checked.

Checking method:
1. Enter the test mode.
2. Press the \[\text{[A]}]/\[\text{V}\] keys to select the “POWER”, and press the \[\text{[B]}\] key to enter the minor item.
3. Press the \[\text{[A]}]/\[\text{V}\] keys to select the “BATTCHK”.
4. Press the \[\text{[C]}\] key, the battery voltage is displayed.
   When the battery voltage cannot be confirmed, “ERROR” is displayed.

**Screen display**

```
POWER BATTCHK
X.XXXV
```

X.XXXV: Battery voltage

5. Press the [BACK] key, return to minor item selection screen.

4-1-6. Battery separation (RMVBATT)
When the battery is removed, this mode is used.

**Note:** Not used for the servicing.

4-2. Audio (AUDIO)
While playing the audio track, it’s in a repeat state. If [BACK] key is pressed, it’s stopped.

Press the \[\text{[C]}\] key to switch the HPOUT/LINEOUT/SPEAKER.

**Screen display**

```
MPTAPP (X.XX.XX)
```

```
POWER
AUDIO
VIDEO
VIDEO OUT
OTHER
DAC
DIREC
SHUTDOWN
EXITTEST
USER1
USER2
USER3
```
4-2-1. Output check (OUTPUT)
“1 kHz 0 dBs L-ch/R-ch VOLUME: 25” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [►] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “OUTPUT”.
4. Press the [◄] key, “1 kHz 0 dBs L-ch/R-ch VOLUME: 25” audio signal is outputted.

Screen display

```
AUDIO OUTPUT
1kHz 0dBs L/Rch
HPOUT [ VOL: 25 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.

4-2-2. S/N check (SN)
“Infinity Zero VOLUME: 25” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [►] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “SN”.
4. Press the [◄] key, “Infinity Zero VOLUME: 25” audio signal is outputted.

Screen display

```
AUDIO SN
Infinity Zero
HPOUT [ VOL: 25 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.

4-2-3. Frequency characteristic 1 check (F1)
“20 Hz 0 dBs L-ch/R-ch VOLUME: 25” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [►] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “F1”.
4. Press the [◄] key, “20 Hz 0 dBs L-ch/R-ch VOLUME: 25” audio signal is outputted.

Screen display

```
AUDIO F1
20Hz 0dBs L/Rch
HPOUT [ VOL: 25 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.

4-2-4. Frequency characteristic 2 check (F2)
“20 kHz 0 dBs L-ch/R-ch VOLUME: 25” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [►] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “F2”.
4. Press the [◄] key, “20 kHz 0 dBs L-ch/R-ch VOLUME: 25” audio signal is outputted.

Screen display

```
AUDIO F2
20kHz 0dBs L/Rch
HPOUT [ VOL: 25 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.
4-2-5. CH separation (L-ch) check (SEPLR)
“1 kHz 0 dBs L-ch VOLUME: 25” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “SEPLR”.  
4. Press the [▶] key, “1 kHz 0 dBs L-ch VOLUME: 25” audio signal is outputted.

Screen display

```
AUDIO SEPLR
1kHz 0dBs Lch
HPOUT [ VOL: 25 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.

4-2-6. CH separation (R-ch) check (SEPRL)
“1 kHz 0 dBs R-ch VOLUME: 25” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “SEPRL”.  
4. Press the [▶] key, “1 kHz 0 dBs R-ch VOLUME: 25” audio signal is outputted.

Screen display

```
AUDIO SEPRL
1kHz 0dBs Rch
HPOUT [ VOL: 25 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.

4-2-7. Maximum output check (MAXOUT)
“1 kHz 0 dBs L-ch/R-ch VOLUME: 30” (Headphone output when AVLS operates: “1 kHz 0 dBs L-ch/R-ch VOLUME: 13”) audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “MAXOUT”.  
4. Press the [▶] key, “1 kHz 0 dBs L-ch/R-ch VOLUME: 30” (Headphone output when AVLS operates: “1 kHz 0 dBs L-ch/R-ch VOLUME: 13”) audio signal is outputted.

Screen display

```
AUDIO MAXOUT
1kHz 0dBs L/Rch
HPOUT [ VOL: 30 ]
AVLS OFF
```

START

5. In this state, each time the [▶] key is pressed, AVLS on/off switch is performed.
6. Press the [BACK] key, return to minor item selection screen.

4-2-8. Normalizer check (NMLZR)
“1 kHz –24 dBs L-ch/R-ch VOLUME: 30” audio signal is outputted.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “NMLZR”.  
4. Press the [▶] key, “1 kHz –24 dBs L-ch/R-ch VOLUME: 30” audio signal is outputted.

Screen display

```
AUDIO NMLZR
1kHz –24dBs L/Rch
HPOUT [ VOL: 30 ]
```

START

5. Press the [BACK] key, return to minor item selection screen.
4-2-9. Sound pressure regulation level check (SPCHK)

"1 kHz 0 dBs L-ch/R-ch VOLUME: 30" audio signal is outputted.

**Checking method:**
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “SPCHK”.
4. Press the [▶] key, “1 kHz 0 dBs L-ch/R-ch VOLUME: 30” audio signal is outputted.

**Screen display**

![Audio SPCHK](image)

5. Press the [BACK] key, return to minor item selection screen.

4-2-10. Speaker check

“20 – 20kHz 0dBs L-ch/R-ch VOLUME: 30” audio signal is outputted.

**Note:** Not used for the servicing.

4-2-11. User specification contents playback 1 (USER1)

“/User1.oma” is reproduced.

**Checking method:**
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “USER1”.
4. Press the [▶] key, “/User1.oma” is reproduced.

**Screen display**

![Audio USER1](image)

XX:XX : Repetition expert totaling time

5. Press the [BACK] key, return to minor item selection screen.

4-2-12. User specification contents playback 2 (USER2)

“/User2.oma” is reproduced.

**Checking method:**
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “USER2”.
4. Press the [▶] key, “/User2.oma” is reproduced.

**Screen display**

![Audio USER2](image)

XX:XX : Repetition expert totaling time

5. Press the [BACK] key, return to minor item selection screen.

4-2-13. User specification contents playback 3 (USER3)

“/User3.oma” is reproduced.

**Checking method:**
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “AUDIO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “USER3”.
4. Press the [▶] key, “/User3.oma” is reproduced.

**Screen display**

![Audio USER3](image)

XX:XX : Repetition expert totaling time

5. Press the [BACK] key, return to minor item selection screen.
4-3. Video (VIDEO)

Screen display

4-3-1. LCD display check (LCD)

Screen display is checked.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “VIDEO”, and press the [▶] key to select the “LCD”.
3. Press the [◄] key, all black is displayed on the screen.
4. In this state, each time the [OPTION] key is pressed, the screen display changes in the following order.

   All black (default) → Color bar (standard) → Color bar (brightness minimum) → All red → All green → All blue → All white → Maximum drawing size confirmation → diagonal gradation (red) → diagonal gradation (green) → diagonal gradation (blue) → diagonal gradation (white)

   Maximum drawing size confirmation:
   All blue (All sides are red) is displayed. Whether red in all sides is seen is confirmed.
5. In this state, each time the [▶] key is pressed, brightness min/max/middle switch is performed.
6. Press the [BACK] key, return to minor item selection screen.

4-3-2. User specification contents playback 1 (USER1)

“/User1.mp4” is reproduced.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “VIDEO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “USER1”.
4. Press the [◄] key, “/User1.mp4” is reproduced.

4-3-3. User specification contents playback 2 (USER2)

“/User2.mp4” is reproduced.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “VIDEO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “USER2”.
4. Press the [◄] key, “/User2.mp4” is reproduced.

4-3-4. User specification contents playback 3 (USER3)

“/User3.mp4” is reproduced.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “VIDEO”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “USER3”.
4. Press the [◄] key, “/User3.mp4” is reproduced.
4-4. Video output (VIDEO OUT)

**Note:** “VIDEO OUT” must select it never. There is a possibility that the problem occurs in destination setting.

**Screen display**

- MPTAPP (X.XX.XX)
- POWER
- AUDIO
- VIDEO
- VIDEO OUT
- OTHER
- CLESTE
- DAC
- DIREC
- FM
- SHUTDOWN
- EXITTEST

4-5. Other (OTHER)

**Screen display**

- MPTAPP (X.XX.XX)
- POWER
- AUDIO
- VIDEO
- VIDEO OUT
- OTHER
- CLOCK
- CLESTE
- DAC
- KEYNUM
- DIREC
- FORMAT
- FM
- DEST
- SHUTDOWN
- SPSET
- FWVER
- LCAPCHK

4-5-1. Clock check (CLOCK)

The movement of an internal clock is confirmed.

**Checking method:**

1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “OTHER”, and press the [►] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “CLOCK”.
4. Press the [►] key, date and time are displayed.
   “START” changes into “OK” if the movement of an internal clock is confirmed.

   **Screen display**

   - OTHER CLOCK
   - XX, XX XX XXXX
   - #:#:#:####
   - START

   XX, XX XX XXXX : Date
   #:#:#:#:#### : Time

5. Press the [BACK] key, return to minor item selection screen.

4-5-2. Key check (KEY)

The operation of the key is confirmed.

**Checking method:**

1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “OTHER”, and press the [►] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “KEY”.
4. Press the [▲] key, all keys are displayed.

   **Screen display**

   - OTHER KEY
   - UP
   - REW
   - PLAY
   - FF
   - DOWN
   - VOL+
   - FF
   - OPTION
   - BACK
   - HOLD
   - SPSET
   - FWVER
   - LCAPCHK
   - START

5. The character corresponding to the key is selected every time the key is pressed. “OK” is displayed if all keys are pressed.
6. Slide the [HOLD] key from ON to OFF, return to minor item selection screen.

4-5-3. Frequency check that presses key (KEYNUM)

The frequency to which the key is pressed, insert/pull out frequency of cradle and insert/pull out frequency of the headphone are displayed.

**Note:** Not used for the servicing.
4-5-4. Format (FORMAT)
The user’s area is formatted, and ICV for the video and ICV for audio are initialized.

Note: Not used for the servicing.
Format the set from “Settings” → “Common settings” → “Reset/Format” → “Format” when it home menu in usually operates when the set should format it.

4-5-5. Destination setting (DEST)
The destination setting, language information, and sound pressure regulation information are written in the NAND flash memory.

Note: Not used for the servicing.

4-5-6. Sound pressure regulation setting (SPSET)
ON/OFF of sound pressure regulation is confirmed.

Note: Not used for the servicing.

4-5-7. Firmware version check (FWVER)
The firmware version is displayed.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “OTHER” and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “FWVER”.
4. Press the [◄] key, the firmware version is displayed.

Screen display

```
OTHER FWVER
X.XX.XX
MODEL NAME
NWZ-####
SERIAL NO
@@@@@@@@
```

X.XX.XX : Firmware version
#### : Model name
@@@@ : Serial No.

5. Press the [BACK] key, return to minor item selection screen.

4-5-8. NAND capacity check (NCAPCHK)
Capacity of NAND flash memory, present bad block, maximum bad block, and vendor ID are displayed.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “OTHER”, and press the [▶] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “NCAPCHK”.
4. Press the [◄] key, capacity of NAND flash memory, present bad block, maximum bad block, and vendor ID are displayed.

Screen display

```
OTHER NCAPCHK
X GB
BADBLOCK
CUR (####)/MAX (@@@@)
VENDOR (XXXXXXX)
$$$$
```

X : Capacity of NAND flash memory
@@@@ : Number of present bad block
(It makes an error the acquisition of the number of bad blocks at “–1”)
#### : Number of maximum bad block
(It makes an error the acquisition of the vendor ID at “–1”)
$$$$ : Vendor of NAND flash memory

5. Press the [BACK] key, return to minor item selection screen.

4-6. CLESTE

```
MPTAPP (X.XX.XX)
POWER
AUDIO
VIDEO
VIDEO OUT
OTHER
CLESTE WCABLE
DAC
WOCABLE
DIREC
FM
SHUTDOWN
EXITTEST
```

4-6-1. Clear stereo setting (With cable) (WCABLE)
This mode is according to an original sound playback, for adjustment to right and left sound.

Note: Not used for the servicing.

4-6-2. Clear stereo setting (No cable) (WOCABLE)
This mode is according to an original sound playback, for adjustment to right and left sound.

Note: Not used for the servicing.
4-7. DAC

Screen display

MPTAPP (X.XX.XX)
POWER
AUDIO
VIDEO
VIDEO OUT
OTHER
CLESTE
DAC——B-GAIN
DIREC——T-GAIN
FM
SHUTDOWN
EXITTEST

4-7-1. BASS-Gain/Fc setting (B-GAIN)
This mode is adjustment for the sound of BASS when playback.

Note: Not used for the servicing.

4-7-2. TREBLE-Gain/Fc setting (T-GAIN)
This mode is adjustment for the sound of TREBLE when playback.

Note: Not used for the servicing.

4-8. DIREC

Screen display

MPTAPP (X.XX.XX)
POWER
AUDIO
VIDEO
VIDEO OUT
OTHER
CLESTE
DAC—OUTPUT
DIREC—REC
FM
SHUTDOWN—PLAY
EXITTEST—FORMAT
MICCHK

4-8-1. Direct recording output check (OUTPUT)
In this mode, the output confirmation is done.

Note: Not used in this model.

4-8-2. Direct recording recording (REC)
In this mode, it records by the format specified in "Direct recording format select".

Note: Not used in this model.

4-8-3. Direct recording playback (PLAY)
In this mode, the sound recorded in “Direct recording recording” is reproduced.

Note: Not used in this model.

4-8-4. Direct recording format select (FORMAT)
In this mode, the recording format is selected.

Note: Not used in this model.

4-8-5. Built-in microphone check (MICCHK)
In this mode, the built-in microphone is checked.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “DIREC”, and press the [ ► ] key to enter the minor item.
3. Press the [▲]/[▼] keys to select the “MICCHK”.
4. Press the [ ▼ ][ ► ] key, the built-in microphone check is begun. In this state, the sound that the built-in microphone perceived is outputted from the headphone.

Screen display

MIC -> HP
[ VOL: 25 ]

5. Press the [BACK] key, return to minor item selection screen.
4-9. FM

Screen display

MPTAPP (XX.XX)
POWER
AUDIO
VIDEO
VIDEO OUT
OTHER
CLESTE
DAC
DIREC
FM—RCVCHK
SHUTDOWN
EXITTEST

4-9-1. Reception output check (RCVCHK)
FM tuning checked.

Checking method:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “FM”, and press the [▶] key to select the “RCVCHK”.
3. Press the [◄] key, “90.00 MHz” is displayed.

Screen display

FM RCVCHK
90.00 MHz
[VOL : 30]
[RSSI : XX]
[Sense-H : XX]
[Sense-L : XX]

4. In this state, each time the [◄] key is pressed, frequency is changes in the following order.

90.00 MHz (default) → 76.00 MHz → 95.75 MHz → 107.75 MHz → 87.50 MHz → 98.00 MHz → 108.00 MHz → 100.00 MHz

5. In this state, each time the [▶] key is pressed, the LCD back-light brightness is switched.
6. In this state, each time the [OPTION] key is pressed, color bar is displayed.
7. In this state, slide the [HOLD] key from OFF to ON. Each time the [▲]/[▼] keys are pressed, frequency changes in 0.05 MHz.
8. Press the [BACK] key, return to minor item selection screen.

4-10. Shutdown (SHUTDOWN)
Function that power supply of set can be turned off without ending static test mode.

Procedure:
1. Enter the test mode.
2. Press the [▲]/[▼] keys to select the “SHUTDOWN”, and press the [▶] key to select the “SURE ?”.
3. Press the [▶][●] key, turn the power off while having entered the test mode.
4-1. CASE SECTION

<table>
<thead>
<tr>
<th>Ref. No.</th>
<th>Part No.</th>
<th>Description</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>X-2581-503-1</td>
<td>CASE (FRONT) (B) ASSY (BLACK)</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>X-2581-684-1</td>
<td>CASE (FRONT) (R) ASSY (RED)</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>X-2581-685-1</td>
<td>CASE (FRONT) (P) ASSY (PINK)</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>X-2581-686-1</td>
<td>CASE (FRONT) (L) ASSY (BLUE)</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>X-2581-687-1</td>
<td>CASE (FRONT) (G) ASSY (GREEN)</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>X-2581-688-1</td>
<td>CASE (FRONT) (N) ASSY (GOLD)</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>3-254-136-01</td>
<td>SCREW (B1.4)</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>4-283-364-01</td>
<td>BUTTON (VOL) (BLACK)</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4-283-364-11</td>
<td>BUTTON (VOL) (RED)</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>4-283-364-21</td>
<td>BUTTON (VOL) (PINK)</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>4-283-364-31</td>
<td>BUTTON (VOL) (BLUE)</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>4-195-816-01</td>
<td>SCREW 0+P2 M1.4 NEW TRU-STAR</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>X-2581-504-1</td>
<td>CASE (REAR) (B) ASSY (BLACK)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>X-2581-689-1</td>
<td>CASE (REAR) (R) ASSY (RED)</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>X-2581-690-1</td>
<td>CASE (REAR) (P) ASSY (PINK)</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>X-2581-691-1</td>
<td>CASE (REAR) (L) ASSY (BLUE)</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>X-2581-692-1</td>
<td>CASE (REAR) (G) ASSY (GREEN)</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>X-2581-693-1</td>
<td>CASE (REAR) (N) ASSY (GOLD)</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>4-283-366-01</td>
<td>SHEET (VOL), ADHESIVE</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>4-283-364-41</td>
<td>BUTTON (VOL) (GREEN)</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>4-283-364-51</td>
<td>BUTTON (VOL) (GOLD)</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>4-283-364-11</td>
<td>BUTTON (VOL) (PINK)</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>4-283-364-21</td>
<td>BUTTON (VOL) (BLUE)</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>4-283-364-31</td>
<td>BUTTON (VOL) (RED)</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>4-283-364-41</td>
<td>BUTTON (VOL) (GREEN)</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>4-283-364-51</td>
<td>BUTTON (VOL) (GOLD)</td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>4-283-364-11</td>
<td>BUTTON (VOL) (PINK)</td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>4-283-364-21</td>
<td>BUTTON (VOL) (BLUE)</td>
<td></td>
</tr>
</tbody>
</table>

**Note:**
- "XX" and "X" mean standardized parts, so they may have some difference from the original one.
- Items marked "*" are not stocked since they are seldom required for routine service. Some delay should be anticipated when ordering these items.
- The mechanical parts with no reference number in the exploded views are not supplied.
- Color Indication of Appearance Parts Example:
  - KNOB, BALANCE (WHITE) . . . (RED)
  - Parts Color: Cabinet's Color
- Refer to "COLOR VARIATION" in the "SERVICING NOTES" (page 7) about color variation of model and destination.

4-1. CASE SECTION

- LCD, battery section

---

**Ref. No.** | **Part No.** | Description                  | **Remark** |
---|---|---|---|
1 | X-2581-503-1 | CASE (FRONT) (B) ASSY (BLACK) |  |
2 | X-2581-684-1 | CASE (FRONT) (R) ASSY (RED)  |  |
3 | X-2581-685-1 | CASE (FRONT) (P) ASSY (PINK) |  |
4 | X-2581-686-1 | CASE (FRONT) (L) ASSY (BLUE) |  |
5 | X-2581-687-1 | CASE (FRONT) (G) ASSY (GREEN)|  |
6 | 3-254-136-01 | SCREW (B1.4)                 |        |
7 | 4-283-364-01 | BUTTON (VOL) (BLACK)        |  |
8 | 4-283-364-11 | BUTTON (VOL) (RED)          |  |
9 | 4-283-364-21 | BUTTON (VOL) (PINK)         |  |
10 | 4-283-364-31 | BUTTON (VOL) (BLUE)         |  |
11 | X-2581-504-1 | CASE (REAR) (B) ASSY (BLACK)|  |
12 | X-2581-689-1 | CASE (REAR) (R) ASSY (RED)  |  |
13 | X-2581-690-1 | CASE (REAR) (P) ASSY (PINK)|  |
14 | X-2581-691-1 | CASE (REAR) (L) ASSY (BLUE) |  |
15 | X-2581-692-1 | CASE (REAR) (G) ASSY (GREEN)|  |
16 | X-2581-693-1 | CASE (REAR) (N) ASSY (GOLD)|  |
17 | 4-283-366-01 | SHEET (VOL), ADHESIVE        |  |
18 | 4-283-364-41 | BUTTON (VOL) (GREEN)        |  |
19 | 4-283-364-51 | BUTTON (VOL) (GOLD)         |  |
20 | 4-283-364-11 | BUTTON (VOL) (PINK)         |  |
21 | 4-283-364-21 | BUTTON (VOL) (BLUE)         |  |
22 | 4-283-364-31 | BUTTON (VOL) (RED)          |  |
23 | 4-283-364-41 | BUTTON (VOL) (GREEN)        |  |
24 | 4-283-364-51 | BUTTON (VOL) (GOLD)         |  |
25 | 4-283-364-11 | BUTTON (VOL) (PINK)         |  |
26 | 4-283-364-21 | BUTTON (VOL) (BLUE)         |  |
27 | 4-283-364-31 | BUTTON (VOL) (RED)          |  |

---

**Ref. No.** | **Part No.** | Description                  | **Remark** |
---|---|---|---|
7 | 4-283-364-41 | BUTTON (VOL) (GREEN)        |  |
7 | 4-283-364-51 | BUTTON (VOL) (GOLD)         |  |
8 | 4-283-366-01 | SHEET (VOL), ADHESIVE        |  |
9 | X-2581-504-1 | CASE (REAR) (B) ASSY (BLACK)|  |
9 | X-2581-689-1 | CASE (REAR) (R) ASSY (RED)  |  |
9 | X-2581-690-1 | CASE (REAR) (P) ASSY (PINK)|  |
9 | X-2581-691-1 | CASE (REAR) (L) ASSY (BLUE) |  |
9 | X-2581-692-1 | CASE (REAR) (G) ASSY (GREEN)|  |
9 | X-2581-693-1 | CASE (REAR) (N) ASSY (GOLD)|  |
10 | 4-195-816-01 | SCREW 0+P2 M1.4 NEW TRU-STAR | (for BLUE, PINK, GREEN, GOLD) |
10 | 4-195-816-11 | SCREW 0+P2 M1.4 NEW TRU-STAR | (for BLACK, RED) |
11 | 4-299-401-01 | SPACER                     |  |
4-2. LCD, BATTERY SECTION

• Rear side view

*About Ref. No. 1000
Please cut out and use POLYIMIDE SHEET for a specified size when you exchange it for new parts. Note: As for this part, the material or thickness might be different compared with before. However, there is no obstacle at all.

<table>
<thead>
<tr>
<th>Ref. No.</th>
<th>Part No.</th>
<th>Description</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>51</td>
<td>4-150-173-01</td>
<td>SHEET (WIRE)</td>
<td></td>
</tr>
<tr>
<td>52</td>
<td>4-155-860-01</td>
<td>ADHESIVE, SHEET (BATT)</td>
<td></td>
</tr>
<tr>
<td>53</td>
<td>4-283-369-02</td>
<td>SUPPORT (M)</td>
<td></td>
</tr>
<tr>
<td>54</td>
<td>4-198-386-01</td>
<td>CUSHION (NAND)</td>
<td></td>
</tr>
<tr>
<td>55</td>
<td>4-283-367-01</td>
<td>ESCUTCHEON</td>
<td></td>
</tr>
<tr>
<td>56</td>
<td>4-257-561-01</td>
<td>SHEET (CORAL) ADHESIVE</td>
<td></td>
</tr>
<tr>
<td>57</td>
<td>4-263-096-01</td>
<td>SPACER (NAND)</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>9-913-402-43</td>
<td>POLYIMIDE SHEET, t=0.075 (for SERVICE)</td>
<td></td>
</tr>
</tbody>
</table>

57 9-885-159-63 EMMC BOARD, COMPLETE (16GB) (for SERVICE) (NWZ-E465)

58 4-257-561-01 SHEET (CORAL) ADHESIVE

59 4-263-096-01 SPACER (NAND)

1000 9-913-402-43 POLYIMIDE SHEET, t=0.075 (for SERVICE)

BAT1 X-2546-032-2 SVX BATTERY ASSY

LCD1 A-1788-689-A LCD ASSY

Unit: mm

Please cut out and use POLYIMIDE SHEET for a specified size when you exchange it for new parts. Note: As for this part, the material or thickness might be different compared with before. However, there is no obstacle at all.
4-3. CHASSIS SECTION

- Rear side view

• About Ref. No. 1000
Please cut out and use POLYIMIDE SHEET for a specified size when you exchange it for new parts.
Note: As for this part, the material or thickness might be different compared with before. However, there is no obstacle at all.

<table>
<thead>
<tr>
<th>Ref. No.</th>
<th>Part No.</th>
<th>Description</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>101</td>
<td>3-234-449-11</td>
<td>SCREW (M1.4)</td>
<td></td>
</tr>
<tr>
<td>102</td>
<td>4-283-371-01</td>
<td>HOLDER (HP)</td>
<td></td>
</tr>
<tr>
<td>103</td>
<td>4-196-036-01</td>
<td>SHEET (HP JACK)</td>
<td></td>
</tr>
<tr>
<td>104</td>
<td>3-234-449-05</td>
<td>SCREW (M1.4)</td>
<td></td>
</tr>
<tr>
<td>105</td>
<td>9-885-159-06</td>
<td>MOTHER BOARD, COMPLETE (for SERVICE)</td>
<td></td>
</tr>
<tr>
<td>106</td>
<td>4-192-485-01</td>
<td>SHEET (MOTHER)</td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>4-209-153-01</td>
<td>SHEET (CHASSIS)</td>
<td></td>
</tr>
<tr>
<td>108</td>
<td>4-195-814-01</td>
<td>SPACER (LCD)</td>
<td></td>
</tr>
<tr>
<td>109</td>
<td>4-195-815-01</td>
<td>SHEET (LCD), ADHESIVE</td>
<td></td>
</tr>
<tr>
<td>109</td>
<td>4-195-815-01</td>
<td>SHEET (LCD), ADHESIVE</td>
<td></td>
</tr>
<tr>
<td>110</td>
<td>X-2581-502-1</td>
<td>CHASSIS ASSY</td>
<td></td>
</tr>
<tr>
<td>1000</td>
<td>9-913-402-43</td>
<td>POLYIMIDE SHEET, t=0.075 (for SERVICE)</td>
<td></td>
</tr>
<tr>
<td>HPJ1</td>
<td>A-1764-100-A</td>
<td>3PIN HP JACK ASSY</td>
<td></td>
</tr>
<tr>
<td>VOL1</td>
<td>A-1828-814-A</td>
<td>VOL KEY ASSY</td>
<td></td>
</tr>
<tr>
<td>W1</td>
<td>1-967-951-11</td>
<td>VOL KEY WIRE</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Ref. No.</th>
<th>Part No.</th>
<th>Description</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.5</td>
<td>13</td>
</tr>
<tr>
<td>3</td>
<td>7</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>

unit: mm

Please cut out and use POLYIMIDE SHEET for a specified size when you exchange it for new parts.
Note: As for this part, the material or thickness might be different compared with before. However, there is no obstacle at all.
## ACCESSORIES

### Ref. No. | Part No. | Description | Remark
---|---|---|---
1-542-892-11 | | HEAD PHONE (MDR-EX083LP/BC9) (Headphones: Black) (for BLACK, RED, GOLD) (EXCEPT NWZ-E463HK) |
1-542-892-21 | | HEAD PHONE (MDR-EX083LP/WC9) (Headphones: White) (for BLUE, PINK, GREEN) (EXCEPT NWZ-E463HK) |
1-835-940-31 | | CORD, PC CONNECTION (USB cable) |
4-28-145-01 | | EARPAD (1 piece) (Included in MDR-ZX100) (NWZ-E463HK) |
4-287-611-12 | | MANUAL, INSTRUCTION (Quick Start Guide) (ENGLISH) (Except Qriocity compatible model) (EXCEPT US) |
4-287-611-22 | | MANUAL, INSTRUCTION (Quick Start Guide) (FRENCH) (Except Qriocity compatible model) (CND, AEP, UK) |
4-287-611-32 | | MANUAL, INSTRUCTION (Quick Start Guide) (GERMAN) (Except Qriocity compatible model) (AEP, UK) |
4-287-611-42 | | MANUAL, INSTRUCTION (Quick Start Guide) (SPANISH) (Except Qriocity compatible model) (AEP, UK, MX) |
4-287-611-52 | | MANUAL, INSTRUCTION (Quick Start Guide) (ITALIAN) (Except Qriocity compatible model) (AEP, UK) |
4-287-611-62 | | MANUAL, INSTRUCTION (Quick Start Guide) (RUSSIAN) (EE) |
4-287-613-12 | | MANUAL, INSTRUCTION (Quick Start Guide) (TURKISH) (EE) |
4-287-613-21 | | MANUAL, INSTRUCTION (for RDP-NWT16) (ENGLISH, FRENCH, GERMAN, SPANISH, ITALIAN) (NWZ-E463K: AEP, UK, MX/E464K) |
4-415-380-11 | | MANUAL, INSTRUCTION (Quick Start Guide) (ENGLISH) (for Qriocity compatible model) (US, AEP, UK) |
4-415-380-21 | | MANUAL, INSTRUCTION (Quick Start Guide) (FRENCH) (for Qriocity compatible model) (AEP, UK) |
4-415-380-31 | | MANUAL, INSTRUCTION (Quick Start Guide) (GERMAN) (for Qriocity compatible model) (AEP, UK) |
4-415-380-41 | | MANUAL, INSTRUCTION (Quick Start Guide) (SPANISH) (for Qriocity compatible model) (AEP, UK) |
8-912-830-90 | | HEADPHONE (MDR-ZX100) (Headphones) (Including Earpad) (NWZ-E463HK) |

### Ref. No. | Part No. | Description | Remark
---|---|---|---
501 | 4-288-523-01 | ATTACHMENT (ER-O) |
502 | A-1837-362-A | RDP-NWT16 (Speaker) (PIN) (NWZ-E464K) |
502 | A-1837-363-A | RDP-NWT16 (Speaker) (BLUE) (NWZ-E464K) |
502 | A-1845-748-A | RDP-NWT16 (Speaker) (BLACK) (NWZ-E463K: E, JE) |
503 | 4-283-332-11 | ATTACHMENT, E (Attachment for speaker) (CLEAR) (NWZ-E464K: for BLUE, PINK) |
504 | 4-193-600-01 | PANEL, STAND (Stand for speaker) (BLACK) (NWZ-E463K/E464K: for BLACK) |
504 | 4-193-600-11 | PANEL, STAND (Stand for speaker) (WHITE) (NWZ-E464K: for BLUE, PINK) |

### Abbreviation
- AUS : Australian model
- CH : Chinese model
- CND : Canadian model
- EE : East European model
- JE : Tourist model
- MX : Mexican model

---

**Ver. 1.1**